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KATA PENGANTAR

Alhamdulillah, segala puji bagi Allah ‘Azza wa Jalla yang telah
memberikan hidayah dan inayah-Nya sehingga penulis dapat menyelesaikan buku
petunjuk praktikum “PENGANTAR ILMU KOMPUTER”. Modul ini disusun
untuk membantu mahasiswa mengimplementasikan algoritma yang ditemui dalam
beberapa mata kuliah Pengantar Ilmu komputer I, Program Komputer I, Analisis
Numerik, Persamaan Diferensial Biasa, Persamaan Diferensial Parsial, Statistika,
dan mata kuliah lain ke dalam suatu bahasa program.

Modul ini memuat tentang proses pengimplementasian algoritma melalui
software Matlab. Dengan beberapa fungsi khusus yang sudah “build in” dalam
Matlab Library, mahasiswa diharapkan dapat dengan mudah membuat program
dalam bahasa nonprosedural yang bersifat singkat dan lugas namun dapat
mengatasi masalah—masalah komplek dalam Matematika.

Atas terselesaikannya penulisan modul ini, penulis juga menyampaikan
terima kasih kepada yang terhormat:

1.  Dekan Fakultas SAINTEK UIN-Maliki Malang;

2. Ketua Jurusan Matematika;

3. Pihak-pihak yang terlibat secara langsung maupun tidak langsung

dalam penyusunan modul ini.

Demi perbaikan kualitas modul ini, kritik dan saran senantiasa penulis
nantikan. Semoga modul ini memberikan manfaat bagi mahasiswa dan pembaca

pada umumnya. Amin ya Rabb.
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MODUL 1 [Praktikum 1 — 4]
PENGENALAN MATLAB, VEKTOR DAN MATRIKS

Pendahuluan

MATLAB (MATrix LABoratory) adalah bahasa tingkat tinggi dan interaktif
yang memungkinkan untuk melakukan komputasi secara intensif. MATLAB
telah berkembang menjadi sebuah environment pemrograman yang canggih yang
berisi fungsi-fungsi build in untuk melakukan pengelolahan sinyal, aljabar linear
dan kalkulasi matematis lainnya. MATLAB juga berisi ftoolbox yang berisi fungs
— fungsi tambahan untuk aplikasi khusus. Penggunaan MATLAB meliputi bidang

Matematika dan Komputasi
Pembentukan Algorithm
Akuisisi Data

Pemodelan, simulasi dan Pembuatan Prototype

L I

Analisis Data, Explorasi, dan Visualisasi Grafik
%  Keilmuan dan Bidang Rekayasa

Beberapa keunggulan Matlab terletak pada:

2. Aspek Komputasional
%  Analisa matrik dan manipulasinya

Reduksi data dan pengolahan data statistik

FFT, statistic korelasi dan kovarian

Pendukung matrik “sparse”

Fungsi trigonometri dan beberapa fungsi komplek lainnya

* % X % %

Fungsi Bessel, beta, dan fungsi kepadatan lainnya

%  Persamaan diferensial linier dan nonlinier
3. Aspek Grafik dan Visualisasi

%  2-D scatter, grafik garis, poligon dan mesh, counter, grafik polar, dan
plot histogram

3%  3-D scatter, grafik garis, poligon, mesh dan plot “wireframe”



*

Grafik dengan variasi permukaan disertasi dengan animasi gambar

dan suara

4.  Aspek Pemrograman

*

L S

Struktur control (FOR, WHILE dan IF)
Manipulasi string

Input file berupa ASCII dan biner
Debugging

Dapat berinteraksi dengan bahasa pemrograman C

o]

Fle Edt Debug Deskiop Window Help
Dw |4 B |[Bef|?

Shorteuts [ Howto Add (2] What's New

lect MATLAE Help or Demos from the Help menu.

About MATLAB X

MATLAB

Disamping sebagai compiler, Matlab juga dilengkapi dengan Toolbox

software yang merupakan satu-satu kecanggihan Matlab. Software ini mencakup

berbagai masalah — masalah besar dalam teknologi tingkat tinggi, di antaranya

adalah:

%  Control system Toolbox, merupakan kumpulan fungsi-fungsi Matlab untuk

pemodelan, analisis dan desain system kontrol otomatis.

3%  Financial Toolbox, merupakan software untuk menyelesaikan beberapa

masalah keuangan dari masalah yang sederhana sampai masalah yang cukup

kompleks.

%  Fuzzy Logic Toolbox, merupakan software untuk mengembangkan desain

“fuzzy” dari tahap “setup” sampai diagnose.



%  Signal Processing Toolbox, merupakan tools untuk menyelesaikan masalah
besar dalam analisa bispektral, model signal linier dan nonlinier,
transformasi FFT dan DCT serta visualisasi spectrum.

3%  Spectral Analysis Toolbox, merupakan tools untuk menganalisa signal
dengan menggunakan “cumulant” atau spectral dengan order tinggi.

%  Image Processing Toolbox, merupakan software khusus dalam matlab
untuk desain filter, analisa citra, manipulasi warna dan lain-lain yang
berkenaan dengan visualisasi citra.

%  Statistics Toolbox, merupakan software yang menangani masalah-masalah
stokastik.

%  System Identification Toolbox, merupakan software untuk melakukan
aktifitas desain system dinamis yang berdasarkan pada input dan output
data.

Selanjutnya silahkan pelajari sendiri tentang Matlab dengan menekan

tombol F1 pada keyboard !
Emmrr—glg

File Edit Debug Desktop ‘window Help
Dw| & Bo o 6| R

Shortcuts [ Howrto Add (2] What's Rew

Fle Edt View Go Favorites Desktop Window Help

Xl O S|

To get started, select MATY

Conterts | index | Search | pemos

Tile: | MATLAB v
. 3 Begin Here ~ — —
Release Notes ® = = b
&3 Installation MATLAB 5 5
= S - |
@ Getting Started
i Examples Functions: Handle Graphics:
Deskiop Tools and Developme = By Category = Object Properties
) Mathematics = In Alphabetical Order

B Programming
& Graphics .
gaer\/‘suahzam” _ || Documentation Set
B Creating Graphical User Interfz
Functions - Categorical List
Functions - Alphabetical List
Handle Graphics Property Bro:

= Getling Started
Introduces MATLAB and gets you started using it

= User Guides

Extemnal Interfaces Provides tutorials and comprehensive information about MATLAE
Extermal Inteffaces Reference b List of User Guides
[#] Release Notes
) Printahle D (PDF " ing Tips
@ Product Page (Web) Provides helpful techniques and shortcuts for programming in MATLABE
& Excel Link
& &3 MATLAB Builder for COM = Examples in Documentation
MATLAE Builder for Excel Lists major examples in the MATLAB documentation
MATLAB Compiler
€3 MATLAB Web Server Product Demos
= &% Rininfarmatice Tanlhoy 4

< | > <

|l

[ o pevroG.. | Timooul.. | @ modum.. | gAModuM.. | glmodubpr.. | g8 Petuniuk.. | <) MATLAB I Heip LI A



Tujuan Khusus Praktikum :
Mahasiswa dapat memahami kegunaan software Matlab dan aplikasinya untuk
vektor dan matriks

1.  Memulai Matlab
Setelah melakukan instalasi MATLAB pada PC, perhatikan icon MATLAB
pada tampilan desktop kemudian “doubleclick” pada icon tersebut. Selanjutnya

akan muncul tampilan seperti pada gambar berikut ini.
Memulai / Mem

Directory yang
sedang aktif

¥ | Coarent Diesotond < o FleomaTLART S wx
Bhowivads [ Howintai [ ihabs Hew
1 LI
Bt s
£ Fies | FieTupe Zira Lasmpaled | To wen acerced, ssleot HATLAP Hely or Defsos frob the Help menu,
=
- L | x|
variable
. Lyt iy | Vrkopace:
yang aktif [ == e
start
I a==

bagian penting di dalam MATLAB, antara lain :

a.  Jendela perintah (Command Window)
Pada command window, semua perintah matlab dituliskan dan diekskusi.
Kita dapat menuliskan perintah perhitungan sederhana, memanggil fungsi,
mencari informasi tentang sebuah fungsi dengan aturan penulisannya (help),
demo program, dan sebagainya. Setiap penulisan perintah selalu diawali
dengan prompt “>>’.

b.  Jendela ruang kerja (Workspace)
Jendela ini berisi informasi penggunaan variabel di dalam memori
MATLAB.

c.  Jendela history (Command History)



Jendela ini berisi informasi tentang perintah yang pernah dituliskan
sebelumnya. Kita dapat mengambil kembali perintah dengan menekan
tombol panah ke atas atau mengklik perintah pada jendela histori, kemudian

melakukan copypaste ke command window.

Beberapa Fungsi Dalam Matlab
Beberapa fungsi yang dapat dipakai dalam Matlab untuk menyelesaikan

beberapa masalah dapat diringkas dalam penjelasan berikut:

a.

Fungsi pengatur umum

>> help fungsi : untuk mengetahui petunjuk pemakaian suatu fungsi

>> fype file.m : untuk menampilkan isi dari M-File

>> pwd : untuk mengetahui subdirektori aktif

>> cd a\ data : memindahkan suatu direktori aktif ke direktori lain yaitu A
dalam subdirectori data

>> dir : untuk menampilkan isi direktori

>> Iren file 1.txt file 1.m : merubah nama filel.txt menjadi file I.m

Fungsi pengatur variabel dan areal kerja

>> save filename : untuk menyimpan variabel dalam file.mat

>> Joad filename : untuk memanggil data yang disimpan dalam file.mat

>> clear : untuk menghapus variabel terdefinisi

>> pack : untuk memampatkan pemakaian memory lembar kerja

>> size(A) : untuk mengetahui ordo matrik A

>> max(A) atau min(4) : untuk mengetahui nilai terbesar dan terkecil dari
elemen matrik A

>> [ength(A) : menginformasikan bilangan terbesar dari ordo matrik A

>> clc: membersihkan layar lembar kerja



Operator numerik dan matrik

>> + : penjumlahan dan penguragan

>>* A perkalian dan perpangkatan

>> /. \ : pembagian kanan untuk bilangan dan pembagian kiri untuk matrik
dan vektor

>> ¢ : transpose vektor atau matrik

OPERATOR array

>> + : penjumlahan dan penguragan

>> * /:perkalian dan perpangkatan

>> ./, .\ : pembagian kanan untuk bilangan dan pembagian kiri untuk matrik
dan vektor

>> ¢ : transpose vektor atau matrik

Penambahan titik dalam operator array disebabkan adanya operasi sederetan
bilangan dalam waktu yang bersamaan. Contoh array x = 0:0.1:10

Operator logika dan relasional

>> <, <= lebih kecil dan lebih kecil sama dengan

>>> >= |ebih besar dan lebih besar sama dengan

>>=: sama atau ekuivalen

>> ~=: tidak sama atau tidak ekuivalen

>> &, |, ~ : dan, atau, tidak

Penulisan fungsi matematika

>> abs(x) : fungsi untuk menghasilkan nilai absolut dari x

>> sign(x) : fungsi untuk menghasilkan nilai -1 jika x <0, 0 jika x =0 dan 1
jikax>1

>> exp(x) : untuk menghasilkan nilai eksponensian natural, ¢*

>> [og(x) : untuk menghasilkan nilai logaritma natural x, In x

>> Jog10(x) : untuk menghasilkan nilai logaritma dengan basis 10, x 10 log
>> sgrt(x) : untuk menghasilkan akar dari nilai x, x

>> rem(x,y) : untuk menghasilkan nilai modulus (sisa pembagian) x

terhadap y



g.  Fungsi M-file
>> disp (‘karakter’) : menampilkan karakter (string)
>> pum2str : mengkonversi numerik menjadi string
>> jnput : meminta user memberikan input
>> pause : menghentikan program sampai user menekan <ENTER>

>> pause(n) : berhenti selama n detik

3.  Matriks
Terdapat 3 jenis format data di MATLAB yaitu skalar, vektor dan matriks.
%  Skalar, ialah suatu bilangan tunggal
%  Vektor, ialah sekelompok bilangan yang tersusun 1-dimensi. Dalam
MATLAB biasanya disajikan sebagai vektor-baris atau vektor-kolom

%  Matriks, ialah sekelompok bilangan yang tersusun dalam segi-empat
2-dimensi. Di dalam MATLAB, matriks didefinisikan dengan jumlah
baris dan kolomnya. Di MATLAB terdapat pula matriks berdimensi
3, 4, atau lebih, namun dalam buku ini kita batasi hingga 2-dimensi
saja.

Sebenarnya, semua data bisa dinyatakan sebagai matriks. Skalar bisa
dianggap sebagai matriks satu baris — satu kolom (matriks 1x1), dan vektor bisa
dianggap sebagai matriks 1-dimensi: satu baris — n kolom, atau n baris — 1 kolom
(matriks 1xn atau nx1). Semua perhitungan di MATLAB dilakukan dengan
matriks, sehingga disebut MATrix LABoratory.

Matriks didefinisikan dengan kurung siku ([ ]) dan biasanya dituliskan
baris-per-baris. Tanda koma (,) digunakan untuk memisahkan kolom, dan titik-
koma (;) untuk memisahkan baris. Kita juga bisa menggunakan spasi untuk

memisahkan kolom dan menekan Enter ke baris baru untuk memisahkan baris.

Contoh vektor-baris dan vektor-kolom:
>> vektorl=[3,5,7]

vektorl =



>> vektor2=[2;4;6]
vektor2 =

2

4

6

Berikutnya kita coba contoh berikut untuk mendefinisikan matriks 3x3.
>> matriksl=[10 20 30

40 50 60

70 80 90]

>> matriks2=[10 20 30; 40 50 60; 70 80 90]

Terlihat bahwa matrix1 dan matrix2 isinya sama, karenanya kita bisa menekan

Enter untuk membuat baris baru, ataupun menggunakan titik-koma.

Kita juga bisa mendefinisikan matriks elemen per elemen.

>> mat(1,1)=100; mat(1,2)=200; mat(2,1)=300;
>> mat (2,2)=400

mat =

100 200

300 400

Kita sekarang akan mencoba menggabungkan variabel yang ada untuk
membentuk matriks baru.

>> gabungl=[vektor2 matriksl]

gabungl =

2 10 20 30

4 40 50 60

6 70 80 90

>> gabung2=[vektorl; matriks2]



gabung2 =
357

10 20 30
40 50 60
70 80 90

Kita harus ingat bahwa matriks gabungan harus memiliki jumlah baris dan
kolom yang valid sehingga membentuk persegi panjang.

Untuk mengetahui ukuran atau dimensi dari matriks yang ada, kita bisa
gunakan command size dan length. size umumnya digunakan untuk matriks 2-
dimensi, sementara length untuk vektor.
>> length (vektorl)
ans =

3
>> gsize (matrixl)

ans =

Menunjukkan panjang vektor1 ialah 3 elemen, dan ukuran matrix1 ialah 3-baris
3-kolom (3x3). Kita juga bisa menyimpan keluaran command dalam variabel

baru.

>> panjang=length (vektor?2)
panjang =
3
>> [Jml baris,jml kolom]=size (gabung5)
jml baris =

3

jml kolom
6



10

Sementara itu, untuk menghitung jumlah elemen dari suatu matriks, kita
pergunakan command prod. Misalkan untuk matriks gabung5, jumlah elemennya
ialah;

>> jml elemen=prod(size (gabungb))

jml elemen =

18

Berbagai matriks khusus yang kerap kita pergunakan dalam perhitungan bisa

dibuat secara efisien dengan command yang telah ada di MATLAB.

Tabel 1

ones(n) membuat matriks satuan (semua elemennya berisi angka 1)
berukuran nxn.

ones(m,n) membuat matriks satuan berukuran mxn.

zeros(n) membuat matriks nol (semua elemennya berisi angka O0)
berukuran nxn.

zeros(m,n) membuat matriks nol berukuran mxn.

eye(n) membuat matriks identitas berukuran nxn (semua elemen

diagonal bernilai 1, sementara lainnya bernilai 0).

rand(n), membuat matriks nxn, atau mxn, berisi bilangan random
rand(m,n) terdistribusi uniform pada selang 0 s.d. 1.

randn(n), membuat matriks nxn, atau mxn, berisi bilangan random
randn(m,n) terdistribusi normal dengan mean = 0 dan varians = 1.

Command ini kerap kita gunakan untuk membangkitkan derau

putih gaussian.




[]
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matriks kosong, atau dengan kata lain matriks 0x0; biasa

digunakan untuk mendefinisikan variabel yang belum diketahui

ukurannya.

Untuk memperdalam pemahaman, mari kita lihat contoh di bawah ini.

>> clear

>> mat 1=5*ones (2, 4)

mat 1

>> mat 2=zeros(2,4)

mat 2

>> mat 3=[eye (4)

mat 3
1 0
0 1
0 0
0 0

SO B O O

= o O O

0 0

0 0
-ones (4) ]

-1 -1 -1

-1 -1 -1

-1 -1 -1

-1 -1 -1

>> bil acak uniform=rand(1l,10)

bil acak uniform =

Columns 1 through 7

0.9501 0.2311 0.6068 0.4860 0.8913 0.7621 0.4565

Columns 8 through 10
0.0185 0.8214 0.4447
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>> gaussian noise=randn(5,1)
gaussian noise =

-0.4326

-1.6656

0.1253

0.2877

-1.1465

Misalkan kita ingin membangkitkan 20 buah bilangan acak gaussian dengan
mean = 5 dan varians = 3.
>> mu=5; %Nilai mean

>> varians=3; %$Nilai wvariansi

>> bil acak gaussian= sqgrt(varians)*randn(1l,20) + mu

bil acak gaussian =

Setiap kali kita menggunakan command rand dan randn, kita akan selalu
Tips mendapatkan nilai keluaran yang berbeda. Hal ini merupakan salah satu

sifat bilangan acak.

Dalam vektor ataupun matriks, indeks digunakan untuk menunjuk
satu/beberapa elemen dari vektor/matriks. Indeks dituliskan di dalam tanda

kurung (') dengan pola umum sebagai berikut.

Untuk vektor:
nama_vektor( indeks )

Untuk matriks:

nama_matriks( indeks_baris , indeks_kolom )

Dalam suatu vektor, elemen pertama diberi indeks = 1, sementara dalam
matriks, indeks menunjukkan nomor baris dan nomor kolom dari elemen yang

ingin ditunjuk. Untuk lebih jelasnya perhatikan contoh berikut ini.
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>> clear

[1 357 91;

>> vektor itu [9; 8; 7; 6; 5]1;

>> matrix = [10 20 30; 40 50 60; 70 80 90];

>> vektor ini

>> vektor ini (1)
ans =

1
>> vektor itu(2)
ans =

8
>> matrix (1, 2)
ans =

20
>> [matrix(l,1l) matrix(1l,2) matrix(1l,3)]
ans =

10 20 30

Kita juga bisa mengambil beberapa baris dan kolom sekaligus dari suatu
matriks dengan operator titik-dua (:). Dalam hal ini tanda titik-dua berarti

“sampai dengan”.

Misalkan untuk mengambil elemen ke-1 sampai ke-3 dari vektor_ini
>> vektor ini(1:3)

ans =

Mengambil elemen ke-3 sampai ke-5 dari vektor_itu
>> vektor itu(3:5)

ans =



Mengambil elemen baris ke-1 sampai ke-2, kolom ke-2 sampai ke-3 dari matrix

>> matrix(l:2,2:3)
ans =
20 30
50 60

Dalam hal lain tanda titik-dua bisa berarti “seluruhnya”.
Misalkan untuk mengambil seluruh elemen dari vektor_ini
>> vektor ini(:)

ans =

Mengambil seluruh baris dan kolom dari matrix

>> matrix(:, :)

ans =
10 20 30
40 50 60
70 80 90

Mengambil seluruh elemen di baris ke-1 dari matrix
>> matrix (1, :)
ans =

10 20 30

Mengambil seluruh elemen di kolom ke-2 dari matrix
>> matrix(:,2)
ans =

20

50

14
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80

Mengambil seluruh elemen di kolom ke-2 dan ke-3 dari matrix

>> matrix(:,2:3)

ans =
20 30
50 60
80 90

Dengan menggunakan indeks, kita bisa mengubah nilai elemen matriks yang telah
ada.

>> vektor ini(1)=1000

vektor ini =

1000 3 5 7 9

>> vektor itu(2:4)=[-1; -1; -1]
vektor itu =

9

-1

-1

-1

5
>> matrix (3, :)=100*ones (1, 3)
matrix =

10 20 30

40 50 60

100 100 100

Deret bilangan merupakan hal yang kerap kita temui dalam pengolahan
data, terutama berkaitan dengan plot data dan proses iterasi (perhitungan

berulang-ulang). Misalkan kita memiliki data tegangan suatu baterai pada setiap
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menit selama 1 jam. Dalam menyajikan data “waktu”, kita harus membuat vektor
berisi deret. Kita tentunya bisa melakukannya secara manual seperti ini:

>> time=[1, 2, 3, 4, .., 60]

Tetapi akan lebih efisien jika deret diciptakan menggunakan operator titik-dua.

Formulanya ialah:

deret = nilai_awal : inkremen : nilai_akhir

Inkremen harus bilangan bulat positif atau negatif

Khusus untuk inkremen = 1:

deret = nilai_awal : nilai_akhir

Sehingga kita bisa tuliskan

>> time=1:60

Sekarang kita akan berlatih menggunakan operator titik-dua untuk membuat deret
berikut:

x =0, 100, 200, 300, 400, ..., 2200, 2300
y=-10,-9.5,-9,-85,...-05,0,0.5,...,9,9.5,10
z=10,9.95,9.9,9.85,9.8,9.75, ... ,1,0.95,0.9, ..., 0.05, 0

>> x=0:100:2300;
>> y=-10:0.5:10;
>> z=10:-0.05:0;

@ Bedakan operator titik-dua untuk manipulasi indeks matriks dengan
Penting! operator titik-dua untuk membuat deret. Untuk membedakannya ingatlah

selalu bahwa indeks selalu berada di dalam tanda kurung ()
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Di dalam MATLAB, pembuatan deret juga bisa dilakukan dengan command

berikut ini.

Tabel 2

linspace(a,b,n) membuat vektor baris berisi n titik yang terpisah merata

secara linier antara a dan b.

logspace(a,b,n) membuat vektor baris berisi n titik yang terpisah merata
secara logaritmik antara 10”*a dan 10*b. Command ini
biasa digunakan untuk menghitung respon frekuensi suatu

sistem.

Contoh:
>> linspace(0,10,11)

ans =

>> logspace(0,2,10)

ans =

Columns 1 through 7

1.0000 1.6681 2.7826 4.6416 7.7426 12.9155 21.5443
Columns 8 through 10

35.9381 59.9484 100.0000

Terdapat beberapa command yang bisa digunakan untuk menukar, merotasi, dan

menyusun kembali elemen matriks.

Tabel 3

fliplr(A) menukar posisi elemen matriks A secara melintang, yaitu
sebelah kiri ditukar dengan sebelah kanan.

flipud(A) menukar posisi elemen matriks A secara membujur, yaitu
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sebelah atas ditukar dengan sebelah bawah.

rot90(A) merotasi posisi elemen matriks A berlawanan arah jarum jam
sejauh 90°.

reshape(A,m,n) menyusun ulang elemen matriks A menjadi berukuran mxn.
Harus diingat bahwa jumlah elemen A harus sama dengan

mxn

>> fliplr (A)

ans =

>> flipud(A)

ans =
4 5 o 7
0 1 2 3
>> rot90 (A)
ans =

o =N W
01 oy




>> reshape (A, 1, 8)
ans =

0 4 1
>> reshape (A, 4,2)

ans =

o = b O
~ W o N

3.1. Penjumlahan dan Pengurangan

19

Penjumlahan dua matriks, A+B, dan selisih dua matriks, A—B, terdefinisi

jika A dan B berukuran sama. Namun demikian, penjumlahan/pengurangan juga

bisa dilakukan antara matriks dengan skalar. Untuk jelasnya mari kita praktekkan

contoh berikut ini.

>> A=[0 1;2 3]:
>> B=[4 5;6 7];

>> Jumlah=A+B, Selisih=A-B,

Jumlah =
4 6
8 10
Selisih =
-4 -4
-4 -4
Tambahb0 =
50 51

52 53

Tambah50=A+50
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3.2. Perkalian Matriks

Perkalian matriks, misalkan C = AB, terdefinisi jika jumlah
kolom di A sama dengan jumlah baris di B. Selain itu, perkalian juga
bisa dilakukan antara matriks dengan skalar.

Kita akan lanjutkan contoh sebelumnya.

>> A,B
A =
0 1
2 3
B =
4 5
6 7

>> MultAB=A*B, MultBA=B*A

MultAB =
6 7
26 31
MultBA =
10 19
14 27

§) Ketika mengalikan dua matriks, maka matriks hasil perkalian
Tips  dihitung berdasarkan formula baku. Misalkan C=AB; A dan B
matriks 2x2,

sehingga hasilnya C juga 2x2.

(C11 C12)_ (a11 alz)(bn b12>
Ca1 €22 Az1 A2/ \by; by,
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dl mana. C11 = a11b11 + a12b21
C12 = Qq1b1p + aq3b;;
Cp1 = Qz1by1 + azby

Caz2 = Qp1b1p + azyby;

Contoh berikutnya ialah perkalian dua vektor, yang juga mengikuti aturan
perkalian matriks, karena vektor sesungguhnya sama dengan matriks 1-
dimensi.

>> x=[3 2 1], y=[100;10;1]

x =
3 2 1
y =
100
10
1

z1l =
321

z2 =
300 200 100
30 20 10
3 2 1

Selain perkalian di atas, dikenal pula perkalian vektor, yaitu:

“dotproduct” (atau disebut juga inner-product), dan “cross-product”.
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dot(x,y) menghitung dot-product dari vektor x dan y

cross(x,y) menghitung cross-product dari vektor x dan y

i | Dot-product dan cross-product dihitung berdasarkan formula baku.

Tips
Yy = (¥1 Y2 ¥3), maka:

dot-product: Xy =X1Y1 + XV, + X3Y3

cross-product: X Xy = (X2¥3 — X3Y2 X3Y1 — X1V3 X1Y2 — X2¥1)

Misalkan terdapat dua vektor x = (x; x, x3) dan

Perlu diingat bahwa hasil dot-product berupa skalar, sementara hasil

cross-product berupa vektor.

3.7. Persamaan Linier dalam Matriks

Kita sering menemui persamaan linier dengan beberapa variabel. Di dalam

aljabar, solusi persamaan tersebut bisa ditemukan, salah satunya dengan

menggunakan matriks. Misalkan kita tinjau sistem persamaan linier dengan

variabel x; dan x,.
X1 — 2x2 = 32

12x1 + 5x2 =7

Dalam bentuk matriks bisa kita tuliskan:

(& D)= eax=5

Dalam MATLAB kita tuliskan:
>> A=[1 -2;12 5]; B=[32;7];
>> X=inv (A) *B
X =
6.0000
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-13.0000

Sehingga kita dapatkan solusi x; = 6 dan x, = -13. Atau kita juga bisa

mendapatkan solusi tersebut dengan operator pembagian terbalik:

>> X=A\B

X =
6.0000

-13.0000

Sebagai bahan latihan, cobalah Anda pecahkan persamaan linier dengan tiga
variabel berikut ini.
x+2y+3z=2
4x + 5y +6z=-55
Tx + 8y —9z=-49

3.8. Transposisi
Salah satu operasi yang penting dalam matriks ialah transposisi, dituliskan
dalam MATLAB dengan operator petik tunggal ( ‘) dan titik-petik (. ). Operasi

ini mempertukarkan baris dan kolom dari suatu matriks atau vektor.

Tabel 4

petik tunggal (¢) operasi transposisi untuk matriks berisi bilangan riil, atau
transposisi dan konjugasi untuk matriks kompleks.
titik-petik (.’ ) operasi transposisi tanpa konjugasi. Untuk matriks riil,

operator ini memberi hasil yang sama dengan petik tunggal

Mari kita praktekkan contoh berikut ini untuk memahami kedua operator di atas.

>> Mat riil=[1 0; 3 5], Mat kompleks=[1+21 3i; 1 2+31i]

Mat riil =
1 0
3 5

Mat kompleks =
1.0000 + 2.00001 0 + 3.00001
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1.0000 2.0000 + 3.00001

>> Transp riil=Mat riil', Transp kompleks=Mat kompleks'
Transp riil =
1 3
0 5
Transp kompleks =
1.0000 - 2.00001 1.0000
0 - 3.00001 2.0000 - 3.00001

>> Transp riil2=Mat riil.'
Transp riil2 =

1 3

0 5

>> Transp_ kompleks2=Mat kompleks.'
Transp kompleks2 =
1.0000 + 2.00001 1.0000
0 + 3.00001 2.0000 + 3.00001

3.9. Operasi Elemen-per-Elemen

Di dalam MATLAB, operasi matematik juga bisa dilakukan elemen-per-
elemen. Dalam hal ini matriks atau vektor yang terlibat harus berukuran sama.
Operasi yang bisa dilakukan ialah perkalian/pembagian, penjumlahan/
pengurangan, serta pangkat. Operator yang digunakan diawali dengan tanda

“titik” (kecuali penjumlahan/pengurangan), yaitu:

Tabel 5
+ - Tambah dan kurang (elemen-per-elemen)
RV Kali, bagi, bagi terbalik (elemen-per-elemen)

N Pangkat (elemen-per-elemen)
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Operasi penjumlahan/pengurangan matriks secara definit sudah dilakukan elemen-

per-elemen, sehingga + dan — tidak diawali “titik”.

Sekarang kita coba praktekkan contoh di bawah ini.

>> A=[1 -2;1 5]; B=[7 5; 2 0];

>> A+B
ans =
8 3
3 5
>> A.*B
ans =
7 -10
2 0
>> B./A
ans =
7.0000 -2.5000
2.0000 0
>> B."2
ans =
49 25
4 0
>> A."B
ans =
1 -32
1 1

>> 2.”B
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ans =

128 32

Perhatikan bahwa hasil operasi juga berupa matriks berukuran sama dengan A
dan B.

Pada contoh berikutnya kita coba operasi antar vektor.

>> a [3 2 1]; b = 1[4 5 06];

[10 20 30]"; 4 = [5 10 15]17;

>> C

>> a.*b
ans =

12 10 6

>> c.*d
ans =
50
200
450
>> a.*c
??? Error using ==> .*

Matrix dimensions must agree.

Perhatikan bahwa ukuran a dan c tidak cocok sehingga muncul pesan error (a
berukuran 1x3 sementara ¢ 3x1).
>> b.%a, c./d+2
ans =
64 25 6
ans =

4
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>> c./2.%d."2
ans =
125
1000
3375

Ingat, operasi pangkat selalu dilakukan lebih dulu, diikuti perkalian/pembagian,

kemudian penjumlahan/pengurangan.

3.10. Fungsi Elemen-per-Elemen

Semua fungsi matematik yang berlaku pada skalar (lihat kembali subbab
2.4), berlaku pula untuk matriks/vektor secara elemen-per- elemen. Pada contoh
kali ini, kita akan mencoba beberapa contoh sederhana, kemudian kita coba pula
dua kasus perhitungan dengan memanfaatkan berbagai fungsi yang telah kita

pelajari.

>> round(n./2), floor(n./2), ceil(n./2)
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ans =

-2 -1 -1 0 1 1 2
ans =

-2 -1 -1 0 0 1 1
ans =

-1 -1 0 0 1 1 2

Contoh kasus:

Anda ditugasi membuat tabel trigonometri: sinus dan cosinus untuk sudut-
sudut istimewa: 0°, 30°, 45°, 60°, 90°, ... , 360°. Dalam tugas ini akan digunakan
pula command sort untuk mengurutkan data dan disp untuk menampilkan isi
variabel di layar.

Mula-mula, kita definisikan x sebagai sudut-sudut istimewa, berupa sudut
kelipatan 30° mulai 0° hingga 360°. Kemudian kita tambahkan empat sudut

istimewa: 45°, 135°, 225°, dan 315°, lalu kita urutkan isi vektor x.

>> clear
>> x=0:30:360;
>> x=[x 45 135 225 315];

>> x=sort (x)

%X =

Columns 1 through 13

0 30 45 60 90 120 135 150 180 210 225 240 270

Columns 14 through 17
300 315 330 360
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x dalam satuan derajat kita ubah menjadi t (radian), karena perhitungan

trigonometri dilakukan dalam satuan radian.

>> t=x.*pi/180;

>> yl=sin(t); y2=cos(t);

Selanjutnya kita buat matriks tiga kolom bernama tabel berisi: sudut, sin, dan cos.

>> tabel=[x;yl;vy2]"';

>> judul=' sudut sin cos';

Ingat, vektor x, y1, dan y2 berupa satu baris; padahal kita ingin menampilkannya

memanjang ke bawah berupa kolom, jadi perlu dilakukan transposisi.

>> disp (judul), disp(tabel)

sudut sin cos

0 0 1.0000
30.0000 0.5000 0.8660
45.0000 0.7071 0.7071
60.0000 0.8660 0.5000
90.0000 1.0000 0.0000
120.0000 0.8660 -0.5000
135.0000 0.7071 -0.7071
150.0000 0.5000 -0.8660
180.0000 0.0000 -1.0000
210.0000 -0.5000 -0.8660
225.0000 -0.7071 -0.7071
240.0000 -0.8660 -0.5000
270.0000 -1.0000 -0.0000

300.0000 -0.8660 0.5000



315.0000
330.0000
360.0000

-0.7071
-0.5000
-0.0000

0.7071
0.8660
1.0000
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MODUL 2 [Praktikum 5 - 7]
GRAFIK DAN SUARA
Salah satu keunggulan MATLAB ialah kemampuannya dalam menampil-
kan/mengolah grafik dan suara dengan command yang sederhana dan fleksibel.
Pada bab ini ini kita akan belajar mengenai visualisasi data (plot grafik 2-dimensi

dan 3-dimensi), serta penyuaraan.

Tujuan Khusus Praktikum :

Mahasiswa dapat menjalankan fungsi-fungsi Matlab untuk menyelesaikan masalah
visualisasi

1.  Plot 2-Dimensi

Untuk memvisualisasi data secara 2-dimensi ataupun 3-dimensi, kita
menggunakan berbagai command plotting; di mana command yang paling dasar
ialah plot. Anda bisa praktekan contoh berikut ini.
>> x = 1:8; y=[20 22 25 30 28 25 24 22];
>> plot (x,vVy)
Akan muncul window baru berisi figure hasil plotting. Perhatikan kegunaan dari

ikon yang ada.

) Figure No. 1 H=l B3
di ™ - oz Windo Helngd m
CESHI 227 RPED—5 poate
\ klik ikon ini, lalu drag di
New figure, z ' dalam Tigure"untuk memutar
open, save,/ﬁ figure; terutama untuk figure
print 3-dimensi
250
o 8
1 Insert ]
55| menambahkan Klik ikon ini’-jalu klik di dalam |
teks, panah, dan figure untuk rbesar
241 garis ke dal dan memperkecil
5} figure
22}
a3
20 '
1 2 = 4 5 B 7 =
A
Edit plot

Klik ikon ini, pilih obyek yang ada di figure {ganis plot, area plot, dsb), lalu
double-click untuk mengubah properties dari obyek tersebut.

Gambar 4
Jendela figure

31
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Seperti yang Anda lihat, titik (1,20), (2,22), (3,25), (4,30), dst... terhubung
dengan garis lurus. Sekarang Anda bisa coba untuk membalik urutan sintaks dan
mengamati grafik yang dihasilkan!

>> plot (y, x)

Setiap gambar di figure window, bisa Anda print melalui menu File=>Print
(Ctrl+P), atau Anda simpan File=>Save (Ctrl+S), ataupun Anda ekspor sebagai
file JPG, EMF, BMP, dsb dengan File=>Export.

Untuk menambahkan judul, label, dan grid ke dalam hasil plot Anda,

digunakan command berikut ini.

Tabel 6
xlabel memberi label pada sumbu-x
ylabel memberi label pada sumbu-y
title memberi judul di atas area plot
grid on memunculkan grid di dalam area plot

grid off menghapus grid

Sekarang mari kita lihat contoh plot yang lain. Kita akan memplot kurva y = x?

pada rentang x = —3 hingga x = +3.

>> clear

>> x=-3:0.1:3; %$inkremen=0.1 agar kurva terlihat mulus
>> y=x."3;

>> plot (x,vVy)

>> xlabel ('Sumbu X'), ylabel ('Sumbu Y')

>> title('Kurva Y=X"3"'")

>> grid on
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Kurva Y=
0

20+ S

20+ £ a

.3,(13

o i 2 3
Sumibi X

Gambar 5
Contoh plot: kurva Y = X3

ta

Ketika Anda menggunakan command plot, gambar sebelumnya di figure window

akan terhapus. Lalu bagaimana jika kita ingin memplot beberapa fungsi dalam

satu figure sekaligus? Dalam hal ini kita bisa gunkan command hold.

Tabel 7
hold on untuk ‘menahan’ gambar sebelumnya supaya tak terhapus ketika
ditimpa gambar baru
hold off untuk menonaktifkan command hold

Berikut ini contoh memplot beberapa kurva eksponensial negatif sekaligus.

>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

clear

x=linspace (0, 5,500);

yl=exp (-x); plot(x,vyl);

grid on

hold on

y2=exp (-0.5*x); plot(x,vy2);

y3=exp (-0.25*x); plot(x,y3);

yd=exp (-0.1*x); plot(x,vy4);

xlabel ('sumbu-x"'), ylabel ('sumbu-y')

title ('Perbandingan fungsi eksp onensial

negatif')
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Perbandingan fungsi exsponensial negatit

Samb-x

Gambar 6
Hasil plot dengan “hold on”

2.  Lebih Jauh Mengenai Plot

Anda mungkin ingin memplot beberapa fungsi dalam beberapa figure
window yang terpisah, atau membagi satu window menjadi sejumlah area plot,
ataupun mengatur properties dari plot yang akan digambar. Beberapa command

di bawah ini bisa digunakan untuk tujuan tersebut.

Tabel 8
figure menciptakan figure window baru yang kosong dan siap untuk
di-plot
figure(k) untuk ‘menduduki’ figure window nomor-k

subplot(m,n,k) membagi figure window menjadi m-baris x n-kolom area plot
yang terpisah, dan menduduki area ke-k
clf “clear figure”, mengosongkan figure window yang sedang

‘diduduki’

Misalkan figure window berikut dibagi menjadi 2-baris x 2-kolom dengan

subplot. Perhatikan urutan nomor area dari kiri-atas ke kanan-bawah.




) Fiquie Ho. 2

Fie Ecit Wiew lnzet Tecls Window  Help
Deds kA Ay 225

1 1

0s 0s
Area ke-1 Area ke-2

05 0.&
gsl 0 eessssmemsas gl s .
02 0z

o . Rl

1] 05 1 ‘.'EHJ (153 1
"l
'l

1 --"‘- !

0& ot 08
LIS ERRN RN EEEEEEEE

oG 06
i Area ke-3 2 Area ke-4
0z 0z

I:IIZI 0s 1 IjIZI 05 1

Gambar 7

Pembagian area plot dengan “subplot”

Tabel 8 (lanjutan)
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plot(x,y,’string’) menciptakan plot 2-dimensi dari vektor x versus vektor vy,

dengan property yang ditentukan oleh string, sebagai berikut:

Warna Jenis Garis Jenis Point

b biru - utuh titik

g hijau titik-titik o lingkaran

r merah -.  titik-strip tanda x

¢ biru muda -- putus-putus + tanda +

m ungu * tanda *

y kuning s bujur sangkar

k hitam d permata

w putih v segitiga ke bawah

A segitiga ke atas
< segitiga ke kiri
> segitiga ke kanan

p segilima

h segienam
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Misalkan:

plot(x,y,’r-’)  memplot x versus y dengan garis utuh warna merah

plot(x,y,’k*’)  menempatkan tanda * warna hitam untuk setiap titik x versusy.

plot(x,y,’g--s’) memplot dengan garis putus-putus warna hijau dan
menempatkan tanda bujur sangkar di setiap titik x versusy.

Perlu diingat bahwa °‘string’ dalam plot bersifat opsional. Apabila tidak

dituliskan maka digunakan garis utuh warna biru.

Tabel 8 (lanjutan)

plot(x1,y1,’string1’,x2,y2,’string2’,x3,y3,’string3’, ... )
menciptakan sejumlah plot sekaligus dalam satu area plot: x1
versus y1 dengan property stringl, x2 versus y2 dengan property
string2, dan seterusnya

legend(‘ket1’,’ket2’,’ket3’, ...)
menambahkan legenda ke dalam plot yang telah dibuat; ketl
untuk plot pertama, ket2 untuk plot kedua, dan seterusnya

axis off menghilangkan tampilan sumbu koordinat pada plot

axis on menampakkan kembali sumbu koordinat

axis([x_awal x_akhir y_awal y_akhir])
membuat tampilan area plot pada batas-batas
nilai x = x_awal hingga x_akhir, dan

nilai y =y_awal hingga y_akhir

axis equal  mengubah skala sumbu-x dan sumbu-y menjadi sama

axis square mengubah bentuk area plot menjadi bujur sangkar

Berbagai fungsi yang berkaitan dengan plot di atas, berlaku pula untuk plot
diskrit, plot logaritmik dan plot dalam koordinat polar.
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Tabel 9
stem( ... ) sama dengan plot( ... ), tetapi menampilkan y sebagai data
diskrit
semilogy( ... ) sama dengan plot( ... ), kecuali sumbu-y menggunakan skala

logaritmik (basis 10)

semilogx( ... ) sama dengan plot( ... ), kecuali sumbu-x menggunakan skala
logaritmik
loglog( ... ) sama dengan plot( ... ), tetapi sumbu-x dan sumbu-y

menggunakan skala logaritmik

polar(theta,rho,’string’)
membuat plot dalam koordinat polar dari sudut theta (satuan
radian) versus radius rho, dengan property ditentukan oleh

string

Kini saatnya mencoba berbagai command di atas dalam contoh berikut ini.

Pertama, kita akan mencoba memplot kurva eksponensial negatif seperti pada

contoh subbab 5.1 secara lebih efisien.

>> clear

>> x=linspace (0,5,500);

>> yl=exp(-x); y2=exp(-0.5*x); y3=exp(-0.25*x);
>> yd=exp (-0.1*x%);

>> plot (x,v1l,x,v2,%Xx,¥3,%,v4)

>> grid on

>> xlabel ('sumbu-x'), ylabel ('sumbu-y')

>> title('Kurva y = exp(-Ax)"'")

>> legend('A=1','A=0.5",'A=0.25"," A=0.1")
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Kemudian, kita coba memplot kurva tersebut dalam skala semilogaritmik

>>

>>

>>

>>

>>

>>

figure

semilogy(x,vyl,%x,vy2,%x,y3,%X,y4)

grid on

xlabel ('sumbu-x"'), ylabel ('sumbu-y')
title('Kurva y = exp(-Ax)"'")
legend('A=1",'A=0.5","'A=0.25"," A=0.1")

Misalkan kita ingin menyempitkan area plot pada y = 1 hingga 10% saja, maka:

>>

axis ([0 5 le-2 11])

KUV y = BpiaA)

UMby
a

o 0.5 1 135 2 25 3 335 4 435 3
SANTIb-E

Gambar 8
Contoh plot semi-logaritmik

Dalam contoh kedua, kita akan memplot gelombang sinus, cosinus, kotak, dan

gigi gergaji dengan melibatkan command subplot.



>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

>>

figure

t=0:0.05:10;

sinus=sin (2*pi*0.25*t) ;

cosinus=cos (2*pi*0.25*t) ;

kotak=square (2*pi*0.25*t) ;

gigi=sawtooth (2*pi*0.25*t) ;

subplot (2, 2,

1),

plot (t,sinus), title('sinus 1/4 Hz')

subplot (2, 2,

plot (t,cosinus),

subplot (2, 2,

2);

3);

plot (t, kotak), title('kotak 1/4 Hz')

subplot (2, 2,
plot (t,gigi)

4);

, title('gigi gergaji 1/4 Hz')

sinus 14 Hz cosinus 154 Hz

kolek 14 Hz gigi pargaji 14 Hz

1 - m

title('cosinus 1/4 Hz')

Gambar 9
Contoh penggunaan subplot
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Dalam contoh ketiga, kita akan mencoba memplot suatu fungsi matematis dalam

koordinat polar. Diinginkan plot fungsi:
= sin2 (3 )

dalam MATLAB dituliskan

>> figure

>> theta=linspace (0, 2*pi, 500);
>> rho=(cos (theta.*3)) ."2;

>> polar (theta, rho);

}U 200

2rn

Gambar 10
Contoh plot dengan command “polar”

3.  Plot 3-Dimensi

Dalam subbab ini akan dibahas tiga macam plot 3-dimensi: plot garis, plot
permukaan (surface), dan plot kontur.
3.1. Plot Garis

Mari kita mulai dengan plot garis di dalam ruang 3-dimensi. Ini mirip
dengan plot 2-dimensi, tetapi kali ini kita gunakan command plot3( ... ), dan

dibutuhkan vektor z, untuk dimensi ketiga.
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>> X = [10 20 20 10 107;
> Y = [5 5 15 15 57;
> 7 = [0 0 70 70 071;

>> plot3(X,Y,Z2); grid on;

>> xlabel (‘sumbu X’); ylabel (‘sumb u Y’);
>> zlabel (‘sumbu Z');

>> title (‘Contoh plot 3-D');

>> axis ([0 25 0 20 0 80])

Contoh piot 3-0

e . 2 ap
10 —

o p
sumba ¥ sumbu X

Gambar 11
Contoh plot 3-dimensi dengan command “plot3”

Perhatikan bahwa command label, title, grid, axis, hold, dan subplot
juga berlaku di sini. Anda juga bisa merotasi gambar 3- dimensi tersebut dengan

cara men-klik ikon rotate dan dragging mouse di atas gambar.
Sekarang kita coba contoh yang lain untuk menggambarkan helix.
>> t=0:0.1:25;

>> X=sin(t); Y=cos(t); Z=0.5*t;
>> plot3(X,Y,27)



42

>> xlabel (‘sumbu X’); ylabel (‘sumbu Y’);
>> zlabel (‘sumbu Z2');

>> title (‘Helix'’);

Heliz.

08 T

Fi

sumkR =15

Gambar 12
Contoh penggunaan “plot3”

3.2. Plot Permukaan

Sementara itu, untuk plot permukaan (surface) dalam ruang 3- dimensi

digunakan command mesh atau surf. Contoh berikut ini menggambarkan fungsi

dua variabel z = x? + y?
Caranya ialah:
1)  Definisikan batas-batas nilai x dan y yang akan diplot
2)  Gunakan command meshgrid untuk “mengisi” bidang-XY dengan
jalinan titik
3)  Hitunglah fungsi 3-dimensi untuk jalinan titik tersebut

4)  Buatlah plot dengan command mesh atau surf.
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Sebagai contoh:

>> batas x = -10:1:10; batas y = -10:4:10;
>> [X,Y] = meshgrid(batas x,batas vy);

>> 7Z = X."2 + Y."2;

>> mesh(X,Y,Z);

Kini Anda mendapatkan plot 3-dimensi. Kini cobalah

>> surf (X,Y,Z2);

Gambar 13
Hasil plot dengan “mesh” dan “surf”

Amatilah perbedaan hasil antara mesh dan surf ! Anda juga bisa menambahkan

“label” dan “title” seperti plot pada umumnya.
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Sekarang kita coba contoh yang lain untuk memplot fungsi 3- dimensi

>> x = linspace(-10,10,40); vy = x;
>> [X,Y] = meshgrid(x,y):;

>> R

sgqrt (X."2+Y."2);
>> 7 = sin(R) ./ (R+eps);

>> surf (X,Y,Z2);

Gambar 14
Plot 3-dimensi dari fungsi sin(r)/r

di sini kita menggunakan variabel eps, untuk mencegah perhitungan 0/0 ketika
R=0.
3.3. Plot Kontur

Fungsi dua variabel, misalkan z = f(x,y) bisa kita gambarkan konturnya
dalam dua dimensi dengan command berikut ini:

Tabel 10

contour(X,Y,Z) menggambar kontur dari nilai di Z dengan 10 level.
Elemen Z diterjemahkan sebagai level-level di atas

bidang (x,y)

C = contour(X,Y,Z) | menghitung matriks kontur C

contour(X,Y,Z,n) menggambar kontur dengan n level
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contour( ... , ‘string’) | menggambar kontur dengan property yang ditentukan

oleh string (lihat Tabel 8)

clabel(C) menuliskan angka pada garis-garis kontur untuk

menunjukkan level

meshc(X,Y,Z) menggambar permukaan seperti pada command mesh,

dan juga memplot kontur pada dasar grafik.

Mari kita gambarkan kontur dari fungsi sin(r)/r di atas, lalu bandingkan dengan
plot permukaannya:

>> figure; contour(X,Y,Z);

>> figure; meshc(X,Y,Z);

n
]

]

08 Tk iy e
T - o i =

Gambar 15
Contoh plot kontur
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5.  Suara
Untuk menyuarakan suatu vektor, ataupun membaca dan menyimpan file
audio berformat WAV, digunakan command berikut ini:

Tabel 11

[x,Fs] = wavread(‘nama_file’)

membaca file WAV dan menyimpannya dalam vektor x, serta
mengembalikan frekuensi sampling Fs dari file tersebut.

Command ini juga bisa membaca file WAV multi kanal

wavwrite(x,Fs,’nama_file’)

menuliskan file WAV dari vektor x dengan frekuensi sampling Fs

sound(x,Fs)

menyuarakan vektor x dengan frekuensi sampling Fs

soundsc(x,Fs)

sama seperti sintaks sebelumnya, namun vektor x terlebih

dahulu diskalakan pada selang —1 < x < +1

File yang akan dibaca harus tersimpan di direktori Matlab\work, atau Anda harus
merinci drive, direktori dan nama file jika file tersimpan di direktori lain.
Sebagai gambaran, marilah kita dengarkan suara berikut ini.

Pertama, suara pitch 400 Hz berdurasi 2 detik.

>> Fs=8000; $frekuensi sam pling 8 kHz
>> t=0:1/Fs:2; %$sinyal berdur asi 2 detik
>> frek=400; $frekuensi sin yal 400 Hz

>> m=cos (2*pi*frek*t);
>> sound (m, Fs) ; $suara dari m
>> wavwrite (m,Fs,’tone 400Hz.wav');

%$Menyimpan vektor m ke dalam file

Berikutnya, memperdengarkan suara helikopter yang ada di file heli.wav.
>> [x,Fs]=wavread(‘heli.wav’); %Me mbaca file heli.wav

>> sound (x, Fs); %$Suara helikopter




MODUL 3 [Praktikum 8 — 11]
M-FILE DAN PEMROGRAMAN MATLAB

Pada bab-bab yang lalu, Anda telah belajar berinteraksi dengan MATLAB
menggunakan command window. Sekarang, katakanlah Anda harus
mempergunakan sederetan command secara berulang- ulang di dalam sesi
MATLAB yang berbeda. Akan sangat repot jika Anda harus mengetikkan
command tersebut secara manual di command window setiap kali Anda butuhkan.
Namun dengan M- file, deretan command tersebut bisa Anda simpan dalam
bentuk  skrip teks.  Kapan saja Anda butuhkan, skrip tersebut bisa
dijalankan/dieksekusi secara otomatis dengan cara mengetikkan nama M-file
yang bersangkutan di command window.

Kali ini kita akan belajar mengenal M-file dengan contoh sederhana.
Namun demikian perlu diketahui bahwa MATLAB sebenarnya merupakan
bahasa pemrograman umum, seperti halnya Basic, C, Java, Pascal, Fortran, dll.
Sehingga dalam bab ini kita akan menitikberatkan pada pelajaran pemrograman

komputer.

Tujuan Khusus Praktikum :

Mahasiswa dapat menulis program dalam programming editor dan dapat
menjalankannya dalam lembar kerja Matlab

1. Membuat M-File

Untuk menuliskan skrip M-file, Anda bisa mulai dengan membuka file
baru. Caranya ialah melalui menu di main window: File Open atau File New M-
file; atau dengan mengklik ikon yang ada di jendela utama. Sebuah jendela editor

akan terbuka seperti gambar berikut ini.
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Gambar 16

Jendela editor M-file

Dengan editor ini, kita bisa membuka sejumlah M-file, melakukan editing,
ataupun mencoba menjalankannya dan melakukan debuging (mencari kesalahan
di dalam skrip).
Sementara itu, untuk menyimpan M-file, Anda bisa lakukan dengan menu:
File—>Save atau File=>Save As; ataupun dengan mengklik ikon yang ada.
Namun demikian, sebenarnya Anda juga bisa menuliskan M-file dengan sebarang
editor teks, seperti MS Word, Notepad, dll.; yang penting Anda menyimpan file
tersebut dengan ekstensi *.m.
2. M-File Sebagai Skrip Program

Pada bagian ini, kita akan menggunakan M-file untuk menjalankan
sederetan command yang kita tuliskan sebagai skrip. Mari kita mulai dengan
skrip sederhana untuk menghitung rata-rata dari lima bilangan. File ini kita

namakan rata_rata.m.
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Bukalah M-file baru lalu ketikkan skrip berikut ini.
% Program sederhana untuk menghitung

% rata-rata 5 bilangan:

o°

rata rata.m

a = 50;

b = 100;
c = 150;
d = 200;
e = 250;

% Menghitung dan menampilkan rata-rata

hasil = (a + b + ¢ + d + e)/5;

hasil

Teks yang diawali tanda “%” menunjukkan komentar, dan tidak akan dieksekusi
oleh MATLAB.

Simpanlah file ini di dalam direktori Matlab\work dengan nama
rata_rata.m. Sekarang cobalah jalankan dari command window. Sebelumnya
pastikan bahwa direktori menunjuk ke Matlab\work. Perhatikan “Current
Directory” yang ada di jendela utama MATLAB. Kita bisa mengubah direktori

yang sedang aktif melalui drop-down menu ataupun melalui browse.

«) MATLAH H=E
Fie Edt “ew Web ‘window Help
[ ﬁ|g m1g.;l,|§|? rt Drectory: '_J'
z #| Ce vl Bu ML X
= i | B | = e ¥ Uslony Toof C-iatlabhesterriesampiesicampier Pl
[riedatiabiacrkinckerta
Heme ISiz: I/Eyt::! To get st|Coidsilaborork Fradi -H
. L7 Coidallatra ook Tegul
Direktori yajng Jawa. i 0. [OE| Lot orkimus
sedang aktif at sva| G OKTUS ohek B 0y
at. 3o U eatlabiwoekicheherised Lk
ar oum, [eibdardla b ork lbur s ey otfmized lic
- — Cristsilsbvaerk Lislmise Le
J | » at. = CPEEEWCH Fesd Saloman Teglh |
{I 3 WDMFBEE current Diractary I at 5, aut. luege, Inayeretchat., ;;D[UEIHEI.E
Kita bisa memilih

direktori dari
‘drop-down menu’
ataupun ‘browse’

Gambar 17
Memilih direktori untuk menjalankan M-file



>> clear

>> rata rata

hasil =

150

>> whos

Name Size Bytes
a 1x1 8
ans 1x1 8
b 1x1 8
C 1x1 8
d 1x1 8
e 1x1 8
hasil 1x1 8

Grand total is 7 elements using 56

Perhatikan bahwa:

Cl ass

do
do
do
do
do
do
do

uble
uble
uble
uble
uble
uble
uble

array
array
array
array
array
array

array

bytes
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%  Di dalam M-file, setiap command diakhiri dengan titik-koma supaya hasil

perhitungan di tiap baris tidak ditampilkan di command window. Kecuali

pada hasil perhitungan yang ingin kita tampilkan, tidak diakhiri titik-koma.
%  Variabel yang didefinisikan di dalam M-file akan disimpan oleh MATLAB

ketika M-file telah dieksekusi.

Di dalam editor, skrip yang kita tuliskan akan memiliki warna tertentu:

%  hijau untuk komentar
%  hitam untuk variabel dan command

3%  biru untuk statement pemrograman.
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Sekarang, marilah kita mencoba M-file lain untuk menghitung sisi miring suatu
segi tiga siku-siku dengan formula phytagoras, menghitung luasnya, dan

kelilingnya.

o°

Program menghitung segi-3 siku-siku: segi3.m

o°

Untuk menghitung sisi miring, lu as, dan keliling

o

Mendefinisikan sisi siku-siku se gitiga
Sisi A = 3;
Sisi B = 4;

o

Menghitung sisi miring

Sisi C = sqrt(Sisi A"2 + Sisi B"2)

o\©

Menghitung luas segitiga
Luas = 1/2* Sisi A * Sisi B
% Menghitung keliling

Keliling = Sisi A + Sisi B + Sisi C

Lalu simpan dengan nama segi3.m.
Sekarang kita panggil M-file tersebut
>> segi3

Sisi C =

Keliling =
12

Sekarang Anda bisa mencoba sendiri membuat program yang lebih menantang,

seperti menghitung dan memplot fungsi 2 ataupun 3-dimensi dengan M-file.
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3.  M-File Sebagai Fungsi
Sebagai skrip program, jika kita ingin mengubah/mengatur parameter

masukan program, maka harus kita lakukan di dalam editor. Padahal seringkali

kita harus menjalankan satu program/algoritma berulang kali dengan nilai
masukan yang berbeda-beda, misalkan dalam proses iterasi atau optimasi. Untuk
keperluan ini, kita bisa menuliskan M-file sebagai suatu fungsi spesifik sesuai
kebutuhan kita.

Dalam setiap fungsi terdapat tiga unsur:

%  Parameter masukan; dalam hal ini kita sebut sebagai “argumen input”.
Jumlah parameter (argumen) tersebut bisa sebarang (satu, dua, sepuluh,
atau tidak ada argumen input sama sekali). Jenis argumen pun sebarang
(variabel, bilangan ataupun teks).

%  Proses di dalam program; berupa sederetan command untuk menjalankan
suatu algoritma tertentu.

%  Parameter keluaran; atau “argumen output” yang jumlah dan jenisnya

sebarang.

Deklarasi fungsi di M-file harus dilakukan pada baris awal dengan sintaks:

function [argumen output] = nama fungsi (argumen input)

Sebagai contoh awal, kita akan membuat fungsi untuk menghitung sisi miring,
luas, dan keliling segitiga; seperti program yang ada pada contoh sebelumnya.
$Fungsi untuk menghitung segi-3 si ku-siku: segitiga.m

%Untuk menghitung sisi miring, lua s, dan keliling

function [Sisi C,Luas,Kll] = segit iga(Sisi A,Sisi B)



$ Me

Sisi

$ Me

Luas

$ Me

K11
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nghitung sisi miring

_C = sqgrt(Sisi A"2 + Sisi B"2) ;

nghitung luas segitiga

= 1/2* Sisi A * Sisi B;

nghitung keliling

= Sisi A + Sisi B + Sisi C;

Lalu simpan dengan nama “segitiga.m”.

Sekarang Anda panggil fungsi tersebut.

>> C
>> [
Hyp
20
Area
96
Circ

48

lear

Hyp,Area,Circum]=segitiga (12,1 6)

um =

Dari contoh sederhana tersebut, ada beberapa hal yang perlu kita perhatikan:

*

Dalam fungsi segitiga, terdapat dua argumen input (Sisi_A, Sisi_B), dan
tiga argumen output (Sisi_C, Luas, KIlI).

Ketika dipanggil di command window, kita bisa menggunakan nama
argumen input/output yang berbeda dengan di M-file, namun urutannya
tidak berubah. Di dalam contoh, argumen Sisi_A dan Sisi_B kita isi
dengan bilangan, sementara argumen Sisi_C, Luas, dan Keliling kita

panggil dengan Hyp, Area, dan Circum.
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Sekarang kita lihat dengan command whos:

>> whos

Name Size Bytes Class

Area 1x1 8 double array
Circum 1x1 8 double array
Hyp 1x1 8 double array

Grand total is 3 elements using 24 bytes

Terlihat bahwa variabel yang dideklarasikan di dalam fungsi tidak disimpan,
melainkan dimusnahkan ketika suatu fungsi selesai dijalankan. Yang ada di sana
hanyalah variabel yang telah  dideklarasikan di command window untuk
menyimpan nilai output. Hal ini merupakan salah satu perbedaan utama antara

skrip program dengan fungsi.

@ Ketika membuat fungsi dengan M-file, nama file harus sama dengan
Penting! nama fungsi yang dideklarasikan dalam sintaks function
Aturan penamaan M-file sama dengan penamaan variabel! Lihat

kembali aturan tersebut di subbab 2.2

Perlu diperhatikan bahwa fungsi yang telah kita buat pada dasarnya sama dengan
fungsi yang telah ada di MATLAB, semisal fungsi sin(x) ataupun sqrt(x).
Misalkan kita memanggil fungsi tanpa menyebutkan argumen output, maka

keluaran akan disimpan di ans.
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4. Display dan Input

Adakalanya kita membutuhkan interaksi dengan pengguna program untuk
memasukkan parameter tertentu di awal/tengah program. Dalam hal ini kita bisa
pergunakan cara sederhana dengan command input. Sementara command disp
digunakan untuk menampilkan teks di layar.
Misalkan kita akan membuat program untuk menghitung jumlah kombinasi team

basket yang mungkin dari sejumlah mahasiswa.

o

Program menghitung kombinasi : h it komb.m

o

untuk menghitung jumlah kombinas i

o

dari sejumlah populasi

o

Menampilkan judul program
clc;

disp (‘Menghitung Kombinasi’);

% Meminta masukan dari user

n = input (‘Berapa jumlah mahasiswa vyang ada? : ');

[
Il

input (‘Berapa jumlah personel satu team? : VY);

% Menghitung kombinasi

kombinasi = factorial (n)/factorial (r)/factorial (n-r);

o)

% Menampilkan keluaran
disp (‘'Jumlah kombinasi yang ada = ‘,kombinasi);

Kita coba jalankan program tersebut:

>> hit komb

Menghitung Kombinasi
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Berapa jumlah mahasiswa yang ada? : 8
Berapa jumlah personel satu team? : 5
Jumlah kombinasi yang ada =

56

5.  Control Statement

Seperti halnya bahasa program pada umumnya, kita bisa mengendalikan
arah program dengan berbagai cara, berupa  percabangan arah program
berdasarkan kondisi tertentu, ataupun loop (perhitungan berulang) ketika kita
melakukan iterasi.
5.1. Statement if ... elseif ... else ... end

Ini merupakan statement untuk percabangan program  berdasarkan
satu/beberapa kondisi tertentu. Sintaks yang digunakan dalam MATLAB

meliputi:

if kondisi

Command yang dijalankan jika kondisi dipenuhi

if kondisi

Command yang dijalankan jika kondisi dipenuhi

Dijalankan jika kondisi tidak dipenuhi
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if kondisil

Command yang dijalankan jika kondisil dipenuhi
elseif kondisiZ2

Dijalankan jika kondisi2 dipenuhi
elseif kondisi3

Dijalankan jika kondisi3 dipenuhi

Dijalankan jika kondisi manapun tidak dipenuhi

Selain itu, dimungkinkan pula membuat pernyataan if di dalam pernyataan yang
lain (disebut nested-if), misalkan:
if kondisil
commandl

if kondisiA

commandA
else
commandB
end
else
command?
end
@ jangan keliru menuliskan elseif dan else if, karena keduanya berbeda.
Penting! Yang pertama untuk menguji kondisi alternatif setelah kondisi di if

terdahulu tak dipenuhi; tetapi yang kedua berarti nested-if.
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5.2. Statement switch ... case
Sebagai alternatif dari statement if ... elseif ... else ... end, kita bisa

menggunakan statement switch. Sintaksnya ialah:

Switch nama variabel

case{kondisil, kondisi?2, ...}
Dijalankan jika kondisil atau kondisiZ2 dst...
dipenuhi
case{kondisiA, kondisiB, ...}
Dijalankan jika kondisiA atau kondisiB dst...
dipenuhi
Case(...)
.dst...
default

Dijalankan jika kondisi manapun tidak dipenuhi

5.3. Statement for ... end
Statement ini digunakan untuk loop/perhitungan berulang. Sintaks yang

digunakan dalam MATLAB ialah:

variabel = nilai awal : inkremen : nilai akhir

Command untuk dijalankan

Adapun sintaks yang digunakan untuk membatasi loop mirip dengan yang kita

pakai untuk membuat deret (lihat kembali subbab 3.5). Misalkan untuk

menampilkan bilangan kelipatan 3 dari 30 sampai 100.
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for k = 30:3:100

k
end
Hasilnya ialah:
k =

30
k =

33
k =
k =

99

Sementara untuk nilai inkeremen = 1, cukup dituliskan nilai awal dan akhir.
Misalkan untuk mendaftar bilangan bulat dari —10 hingga 10 dan menyimpannya

dalam satu vektor.

Vektor=[];

for k = -10:10 %dalam hal ini inkremen = 1
Vektor = [Vektor k];

end

Vektor

Menghasilkan:

Vektor =

Columns 1 through 13
-10 -9 -8 -7 -6 -5 -4 -3 -2 -1 0 1 2
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Columns 14 through 21
3 4 5 6 7 8 9 10

Atau untuk memplot kurva parabola:

y = Ax?

y =Ax2
dengan berbagai nilai parameter A4, yaitu 0,5, 1, 1,5, dan 2. Dalam hal ini indeks

vektor A kita iterasi dari 1 hingga indeks terakhir.

figure;
x = linspace(-4,4,500); % mendefinisikan nilai x
A =0.5:0.5:2; % mendefinisikan vektor A

for 1 = 1l:1length ()
y = A(1)* x.72;
plot(x,y);
hold on;

end

grid on;

Menghasilkan:

£

25

b_?ll-

I . e o i
-4 -3 =2 =1 o 1 z 3 4
Sumiti-K

Gambar 18
Contoh plot 4 kurva parabola dengan “for”
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Perhatikan bahwa setiap selesai satu loop, variabel (dalam contoh di atas ialah 1)
akan otomatis mengalami inkremen. Demikian seterusnya hingga nilai_akhir

(yaitu length (A) ) tercapai dan program dilanjutkan ke baris selanjutnya.

5.4. Statement while ... end

Alternatif dari sintaks loop ialah berikut ini

while kondisi
Command untuk dijalankan jika kondisi dipenuhi

end skeluar dari loop jika kondisi tidak dipenuhi

Misalkan untuk memplot fungsi akar kuadrat

y = Bx1/?2

dengan berbagai nilai parameter B.

figure;

x=1linspace (0,4,500);

A=0.5:0.5:2;

i=1;

while i <= length(A)
y = A(1)* x.7(1/2);
plot(x,y); hold on;
i=i+1;

end

grid on;
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Menghasilkan:

4

Aar

Sumiti-X

Gambar 19
Contoh plot 4 kurva dengan “while”

5.5. Statement break dan return
Ketika kita sudah berada dalam suatu loop, kita bisa keluar dengan break
tanpa menunggu nilai_akhir tercapai, atau tanpa menunggu kondisi loop tidak
dipenuhi lagi. Sementara, return digunakan untuk keluar dari fungsi yang
sedang berjalan. Berikut ini gambarannya dalam kasus penentuan apakah suatu
bilangan bersifat prima atau tidak.
Algoritma yang akan digunakan ialah sebagai berikut:
%  User memasukkan satu bilangan bulat positif N sebagai argumen input.
%  Apabila N bukan bilangan bulat positif, maka perhitungan  tidak
dilanjutkan, dan digunakan return untuk keluar.
% N kita coba-coba bagi dengan 2, 3, 4, 5, ... dst. dengan loop. Apabila satu
waktu ditemukan N habis terbagi, berarti N  bukan bilangan prima.
Selanjutnya kita langsung keluar loop dengan break dan menampilkan

hasilnya di layar.
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%  Apabila N tidak pernah habis dibagi oleh 2, 3, 4, ... , N/2 (sampai loop
selesai), maka N pasti bilangan prima. Selanjutnya kita tampilkan di layar
dan program selesai.

%  Untuk mengetahui apakah N habis terbagi atau tidak, kita bisa

menggunakan fungsi rem(N,pembagi).

o

Fungsi untuk menentukan sifat pr ima suatu bilangan:

o\

apa prima.m

o

function apa prima (N)

o\

N : bil. bulat positif yang dima sukkan oleh user

if N <= 0 %Jika N bilangan negatif
disp ('Masukan harus bilangan b ulat positif');
return; $Perhitungan tidak dilanjutkan

end

% Membulatkan N kalau-kalau N bukan bil. bulat

N = round(N) ;

prima = 1; %Kita anggap N bil prima pd awal program

%flag 'prima' kita set jadi satu.

for 1 = 2:floor (N/2)
if rem(N,i) ==

prima=0;

o°

ternyata N tidak prima,

o°

flag 'prima' kita set jadi nol
break; % Keluar dari loop
end

end
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Q

% Menampilkan hasil:
if prima == 0
disp(N), disp('bukan bilangan prima!"');
else
disp(N), disp('adalah bilangan prima!');

end

Simpanlah fungsi ini dengan nama apa_prima.m di dalam direktori

Matlab\work.

Kita coba jalankan fungsi di atas pada command window:

>> apa prima(37)
37

adalah bilangan prima!

>> apa prima(27)
27

bukan bilangan prima!

>> apa prima(-27)

Masukan harus bilangan bulat positif

Perlu diingat bahwa fungsi apa_prima di atas tidak memiliki argumen keluaran,
karena hasil perhitungan langsung kita tampilkan di layar menggunakan disp,

sehingga hasil tersebut tidak bisa disimpan dalam variabel.
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5.6. Statement continue

Statement continue digunakan untuk memaksa program untuk langsung
menuju iterasi berikutnya dari suatu loop, tanpa mengeksekusi command yang
masih ada di bawahnya.

Sebagai contoh, kita akan membuat fungsi untuk mengumpulkan bilangan

tak nol dari suatu vektor.

o

Fungsi untuk mengumpulkan bilangan

o

tak nol di dalam vektor

o

hit taknol.m

function y = hit taknol (x)
% x : vektor masukan

% y : vektor berisi bilangan tak nol dari x

y = [17
for i=1l:length (x)
if x(i)==0
continue
else
y=ly x(1)];
end

end

Sekarang kita coba:

>> X

[00 2 -3.6 00030 -0.61000 01>

>> y = hit taknol (x)
y:
2.0000 -3.6000 3.0000 -0.6000 10.0000
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6.  Operator Perbandingan dan Logika

Seperti yang kita lihat pada subbab 6.5 Control Statement, kita harus bisa
menuliskan kondisi dalam bahasa MATLAB untuk menciptakan percabangan
program ataupun loop. Untuk keperluan ini kita mungkin harus membandingkan
dua variabel (sama atau tidak, lebih besar atau lebih kecilkah?), mengevaluasi
apakah suatu variabel memenuhi satu dari sejumlah syarat, dan sebagainya.

Untuk membandingan dua variabel digunakan operator berikut ini:

Tabel 12
< > lebih kecil, lebih besar
<= >= lebih kecil atau sama dengan, lebih besar atau
sama dengan
== ~= sama dengan, tidak sama dengan

Sementara untuk mengevaluasi logika, digunakan fungsi dan operator:

Tabel 13
and(A,B) atau A & B operasi logika AND antara A dan B
or(A,B) atau A |B operasi logika OR
xor(A,B) operasi logika XOR
not(A) atau ~A operasi logika NOT pada A

A dan B di sini bisa berupa skalar, vektor, maupun matriks, asalkan ukuran A dan
B sama.
Adapun tabel kebenaran yang digunakan pada setiap operasi logika tersebut ialah

sebagai berikut:
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Tabel 14
A B A&B A|B xor(A,B) ~A
nol nol 0 0 0 1
nol bukannol |0 1 1 1
bukan nol | nol 0 1 1 0
bukan nol | bukan nol 1 1 0 0

Perlu diperhatikan bahwa operasi logika memiliki prioritas untuk dihitung lebih

dahulu, kemudian diikuti operasi aritmatika, lalu operasi perbandingan.

Untuk menambah pemahaman, mari kita praktekkan contoh di bawah ini di

command window:

> A = [1 2 0 -1 -2]; B

[1 000 57

V
vV

Q
Il

and (A, B)

>> D=A|B|C

D:

>> B = xor (~A,B)

E:

Sekarang, mari kita mencoba membuat fungsi untuk menentukan suatu tahun
termasuk kabisat atau tidak. Jangkauan tahun yang bisa dihitung ialah 1900
hingga 2500. Kita ketahui bahwa tahun kabisat terjadi pada tahun-tahun
berkelipatan 4, kecuali tahun akhir abad; namun untuk tahun akhir abad

berkelipatan 400 termasuk kabisat pula.




68

% Fungsi untuk mengetahui tahun kabisat atau tidak

Q

% iskabisat.m

function hasil = iskabisat (thn)

% thn : merupakan masukan bilangan bulat positif

% hasil = 1 jika kabisat, 0 jika tidak

if thn<1900 | thn>2500
disp ('Tahun yang valid: 1900 - 2500"');
hasil=[];
return

end

if rem(thn,4)==0 & (rem(thn,100)~= O|rem(thn,400)==0)
hasil=1;

else
hasil=0;

end

Pada fungsi tersebut, terdapat dua control statement “ if ”:
% if thn<19 00 | thn>2500
Berarti jika variabel thn kurang dari 1900 ATAU lebih dari 2500, command
di dalam “ if ” tersebut akan dijalankan.
¥ 1f rem(th n,4)==0 &
(rem(thn, 100)~=0|rem(thn,400)==0)
Berarti jika variabel thn habis dibagi 4 DAN logika
(rem(thn, 100)~=0|rem(thn,400)==0)bernilai 1 (true), maka

command setelah “ if * akan dijalankan.
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Perlu diperhatikan bahwa logika (rem (thn, 100) ~=0|rem(thn, 400)==0)
akan bernilai 1 bila thn bukan tahun abad (kelipatan 100); ataupun kalau tahun
abad haruslah kelipatan 400.

Sekarang kita bisa coba:

>> iskabisat (2005), iskabisat (1972 )

ans =

ans =

1
Fungsi ini hanya bisa mengolah masukan skalar. Lalu bagaimana kalau diinginkan
masukan berupa vektor atau matriks? Kita bisa ubah fungsinya menjadi berikut
ini:

o)

% Fungsi untuk mengetahui tahun ka bisat atau tidak

o)

% iskabisat.m

function hasil = iskabisat (thn)

o\©

thn : merupakan masukan bilangan bulat positif

o\©

hasil = 1 jika kabisat, 0 jika t idak

if sum(sum(thn<1900 | thn>2500))~= 0
disp ('Tahun yang valid: 1900 - 2500"');
hasil=[];
return
end
hasil = rem(thn,4)==0 &
(rem(thn,100)~=0|rem(thn,400)==0) ;
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Sekarang kita bisa coba untuk menentukan tahun kabisat antara 1980 hingga
1990.

>> iskabisat (1980:1990)

ans =

1 0 0 0 1 0 0 0 1 0 0



O
O

O

Jurusan Matematika
W Fakultas Sains Dan "Teknologi
A - Universitas Islam Negeri Maulana Malik Ibrahim




